# Contents

## About this User Guide
- Revision History ................................................................. v
- How to Contact Altera ............................................................. v
- Typographic Conventions ...................................................... vi

## Chapter 1. About This Kit
- Introduction ............................................................................. 1-1
- Kit Features ........................................................................... 1-1
- Documentation ......................................................................... 1-2

## Chapter 2. Getting Started
- Introduction ............................................................................. 2-1
- Before You Begin ..................................................................... 2-1
  - Check the Kit’s Contents ................................................... 2-2
  - Inspect the Board .............................................................. 2-2
  - Hardware Requirements .................................................... 2-2
  - Software Requirements ...................................................... 2-4
  - Quartus II System Requirements ......................................... 2-4
  - Software Installation ......................................................... 2-5
    - Installing the PCI Express Development Kit, Stratix II GX Edition CD-ROM Contents .............................. 2-5
    - Installing the Quartus II Software and MegaCore Functions ............................................................... 2-6
- Licensing Considerations ...................................................... 2-7
- Using the Kit’s Demo Application and Example Design File ............ 2-7
  - Data Flow Block Diagram .................................................. 2-8
  - Install Drivers and PCI Express Development Board ................. 2-9
  - Finish Installing the Drivers, the Development Board, and Execute the Demo Application ...................... 2-9

## Appendix A. Downloading Programming Files to the Development Board
- Introduction ............................................................................. A-1
- Connect the USB-Blaster Cable to the Board .............................. A-1
- Download Example Design SOF and View State Machine Status ............................................................. A-2
About this User Guide

Revision History

The table below displays the revision history for the chapters in this user guide.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Date</th>
<th>Version</th>
<th>Changes Made</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>July 2006</td>
<td>1.0.0</td>
<td>First publication</td>
</tr>
<tr>
<td>All</td>
<td>August 2006</td>
<td>1.0.1</td>
<td>Minor edits to flow and kit contents to reflect production version.</td>
</tr>
</tbody>
</table>

This user guide provides getting started information about the Altera® Stratix® II GX PCI Express development board.

How to Contact Altera

For the most up-to-date information about Altera products, go to the Altera world-wide web site at www.altera.com. For technical support on this product, go to www.altera.com/mysupport. For additional information about Altera products, consult the sources shown below.

<table>
<thead>
<tr>
<th>Information Type</th>
<th>USA &amp; Canada</th>
<th>All Other Locations</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(800) 800-EPLD (3753)</td>
<td>+1 408-544-8767</td>
</tr>
<tr>
<td></td>
<td>(7:00 a.m. to 5:00 p.m. Pacific Time)</td>
<td>7:00 a.m. to 5:00 p.m. (GMT -8:00) Pacific Time</td>
</tr>
<tr>
<td>Product literature</td>
<td><a href="http://www.altera.com">www.altera.com</a></td>
<td><a href="http://www.altera.com">www.altera.com</a></td>
</tr>
<tr>
<td>Altera literature services</td>
<td><a href="mailto:literature@altera.com">literature@altera.com</a></td>
<td><a href="mailto:literature@altera.com">literature@altera.com</a></td>
</tr>
<tr>
<td>Non-technical customer service</td>
<td>(800) 767-3753</td>
<td>+1 408-544-7000</td>
</tr>
<tr>
<td></td>
<td>7:00 a.m. to 5:00 p.m. (GMT -8:00) Pacific Time</td>
<td>Pacific Time</td>
</tr>
<tr>
<td>FTP site</td>
<td>ftp.altera.com</td>
<td>ftp.altera.com</td>
</tr>
</tbody>
</table>
Typographic Conventions

This document uses the typographic conventions shown below.

<table>
<thead>
<tr>
<th>Visual Cue</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold Type with Initial Capital Letters</strong></td>
<td>Command names, dialog box titles, checkbox options, and dialog box options are shown in bold, initial capital letters. Example: <strong>Save As</strong> dialog box.</td>
</tr>
<tr>
<td><strong>bold type</strong></td>
<td>External timing parameters, directory names, project names, disk drive names, filenames, filename extensions, and software utility names are shown in bold type. Examples: \text{fMAX}, \text{\textbackslash qdesigns directory}, \text{d: drive}, \text{chiptrip.gdf file}.</td>
</tr>
<tr>
<td><strong>Italic Type with Initial Capital Letters</strong></td>
<td>Document titles are shown in italic type with initial capital letters. Example: \textit{AN 75: High-Speed Board Design}.</td>
</tr>
<tr>
<td><strong>Italic type</strong></td>
<td>Internal timing parameters and variables are shown in italic type. Example: \textit{tPIA}, \textit{n + 1}. Variable names are enclosed in angle brackets (&lt; &gt;) and shown in italic type. Example: \text{&lt;file name&gt;}, \text{&lt;project name&gt;.pof file}.</td>
</tr>
<tr>
<td>Initial Capital Letters</td>
<td>Keyboard keys and menu names are shown with initial capital letters. Examples: Delete key, the Options menu.</td>
</tr>
<tr>
<td>“Subheading Title”</td>
<td>References to sections within a document and titles of on-line help topics are shown in quotation marks. Example: “Typographic Conventions.”</td>
</tr>
<tr>
<td><strong>Courier type</strong></td>
<td>Signal and port names are shown in lowercase Courier type. Examples: \texttt{data1}, \texttt{tdi}, \texttt{input}. Active-low signals are denoted by suffix \texttt{n}, e.g., \texttt{resetn}. Anything that must be typed exactly as it appears is shown in Courier. For example: \texttt{c:\textbackslash qdesigns\tutorial\chiptrip.gdf}. Also, sections of an actual file, such as a Report File, references to parts of files (e.g., the AHDL keyword \texttt{SUBDESIGN}), as well as logic function names (e.g., \texttt{TRI}) are shown in Courier.</td>
</tr>
<tr>
<td>1., 2., 3., and a., b., c., etc.</td>
<td>Numbered steps are used in a list of items when the sequence of the items is important, such as the steps listed in a procedure.</td>
</tr>
<tr>
<td>■ ○ ●</td>
<td>Bullets are used in a list of items when the sequence of the items is not important.</td>
</tr>
<tr>
<td>✔</td>
<td>The checkmark indicates a procedure that consists of one step only.</td>
</tr>
<tr>
<td>✅</td>
<td>The hand points to information that requires special attention.</td>
</tr>
<tr>
<td>CAUTION</td>
<td>The caution indicates required information that needs special consideration and understanding and should be read prior to starting or continuing with the procedure or process.</td>
</tr>
<tr>
<td>🔴</td>
<td>The warning indicates information that should be read prior to starting or continuing the procedure or processes.</td>
</tr>
<tr>
<td>➡️</td>
<td>The angled arrow indicates you should press the Enter key.</td>
</tr>
<tr>
<td>🔗</td>
<td>The feet direct you to more information on a particular topic.</td>
</tr>
</tbody>
</table>
1. About This Kit

Introduction

The PCI Express (PCIe) Development Kit, Stratix® II GX Edition provides everything you need to develop and test a complete PCIe system based on the Stratix II GX device.

This chapter briefly describes the kit’s features and documentation including:

- The Stratix II GX PCI Express development board
- Quartus® II Software, Development Kit Edition (DKE)
- Reference design
- MegaCore® IP Library CD-ROM

Kit Features

The PCI Express Development Kit, Stratix II GX Edition features:

- The Stratix II GX PCI Express Development Board—a prototyping platform that allows you to develop and prototype high-speed bus interfaces as well as evaluate Stratix II GX transceiver performance.

For specific information about board components and interfaces, refer to the Stratix II GX PCI Express Development Board Reference Manual.

- Reference Design—The reference design is useful for a variety of hardware applications and lets you quickly begin board prototyping and device verification.

- PCI Express Development Kit Application & Drivers—The kit’s application and drivers allow you to process memory read and write transactions to the board. In addition, you can initiate memory or DMA transaction pairs (read and write), as well as read the various configuration and DMA registers.

- Quartus II Software, Development Kit Edition (DKE)—The Quartus II software provides a comprehensive environment for system-on-a-programmable-chip (SOPC) design. The Quartus II software integrates into nearly any design environment, with interfaces to industry-standard EDA tools. The kit includes:
  - The SOPC Builder system development tool
  - A one-year Quartus II software license, Windows platform only
The Quartus II DKE software license allows you to use the product for 12 months. After 12 months, you must purchase a renewal subscription to continue using the software. For more information, refer to the Altera® website at www.altera.com.

MegaCore IP Library CD-ROM, version 6.0—This CD-ROM contains Altera IP MegaCore functions. You can evaluate the MegaCore functions using the OpenCore® Plus feature, which allows you to do the following:
- Simulate the behavior of a MegaCore function within your system
- Verify the functionality of your design, as well as quickly and easily evaluate its size and speed
- Generate time-limited device programming files for designs that include MegaCore functions
- Program a device and verify your design in hardware

You only need to purchase a license for a MegaCore function when you are completely satisfied with its functionality and performance, and want to take your design to production.

The OpenCore Plus hardware evaluation feature is an evaluation tool for prototyping only. You must purchase a license to use an Altera IP function in production designs.

Documentation

The PCI Express Development Kit, Stratix II GX Edition contains the following documents:
- Readme file—Contains special instructions and points to the kit’s documentation.
- Stratix II GX PCI Express Development Board Reference Manual—Provides specific information about the board’s components and interfaces, steps for using the board, and pin-outs and signal specifications.
2. Getting Started

Introduction

The PCI Express (PCIe) Development Kit, Stratix® II GX Edition is a complete PCIe prototyping and testing kit based on the Stratix II GX device. With this kit, you can perform device qualification testing, memory read and write transactions to the board, read the various configuration and direct memory access (DMA) registers, and use the example design’s DMA engine to write to system memory.

In addition to providing a PCIe development board, the kit also includes all of the hardware and software development tools, as well as the documentation and accessories you need to begin developing PCIe systems using the Stratix II GX device.

This user guide will familiarize you with the contents of the kit and walk you through setting up a PCIe development environment.

In this guide, you will do the following:

- Inspect the contents of the kit
- Install the development tools software
- Set up licensing
- Use the kit’s demo application and example design to:
  - Configure the on-board Stratix II GX device
  - Perform memory read and write transactions on the board
  - Read configuration and DMA registers

Before You Begin

Before using the kit or installing the software, be sure to check the kit’s contents and inspect the board to verify that you received all of the items listed in this section. If any of the items are missing, contact Altera® before you proceed. You should also verify that your computer’s hardware and software meet the kit’s system requirements.
Check the Kit’s Contents

The PCI Express Development Kit, Stratix II GX Edition (ordering code: DK-PCIE-2SGX90N) contains the following items:

- Stratix II GX PCI Express development board with an EP2SGX90FF40C3NES Stratix II GX device
- PCI Express Development Kit, Stratix II GX Edition CD-ROM, version 1.0.0, which includes:
  - PCI Express example design
  - PCI Express development kit application and device drivers
- One-year license of Quartus® II Software Development Kit Edition (DKE), Windows only platform
- MegaCore® IP Library CD-ROM
- USB-Blaster™ download cable
- Power supply and adapters for North America, Europe, the United Kingdom, and Japan
- Heatsink/fan combination and board standoff hardware
- Complete documentation
  - Stratix II GX PCI Express Development Board Reference Manual
- Schematic and board design files

Inspect the Board

Place the board on an anti-static surface and inspect it to ensure that it has not been damaged during shipment. Verify that all components are on the board and appear intact.

In typical applications with the PCI Express development board, a heatsink is not necessary. However under extreme conditions the board may require the use of additional cooling to stay within operating temperature guidelines. Power consumption and thermal modeling should be done to determine whether additional cooling is necessary. In the event that it is, a heatsink/fan combination has been provided for your convenience.

Without proper anti-static handling, the Stratix II GX PCI Express development board can be damaged.
Figure 2–1 shows the Stratix II GX PCI Express development board.

Hardware Requirements

To run the demo application design, a single computer with a x8 PCIe slot is required. However, for more flexibility in downloading applications to the Stratix II GX PCI Express development board, a second computer with the Quartus II software is required as the programming host.

All of the other hardware that you need to use the board is provided with the PCI Express Development Kit, Stratix II GX Edition.
Software Requirements

To use the kit’s demo application, you must be running Windows XP.

Install the following software before you begin developing designs for the kit:

- The Quartus II software version 6.0. See “Installing the Quartus II Software and MegaCore Functions” on page 2–6.
- Internet Explorer 4.01 with Service Pack 2 or later to use Quartus II Help. You need a web browser to register the Quartus II software and request license files.

For the latest Quartus II software updates, please check the Altera website, [www.altera.com](http://www.altera.com).

To license the Quartus II software, you will need:

- Your network identification card (NIC) ID.
- The kit’s serial number, which is adhered to both the outside of the development kit’s box and the CD-ROM.

Your NIC ID is a 12-digit hexadecimal number that identifies your computer. Networked (or floating-node) licensing requires a NIC ID or server host ID. When obtaining a license file for network licensing, you should use the NIC ID from the computer that will issue the Quartus II licenses to distributed users over a network. You can find the NIC ID for your card by typing "ipconfig /all" at a command prompt. Your NIC ID is the number on the physical address line, without the dashes.

Quartus II System Requirements

To use the PCI Express Development Kit, Stratix II GX Edition CD-ROM with the Quartus II software provided with the kit, your system must meet the Quartus II software minimum requirements.

For system requirements, refer to the Quartus II Installation & Licensing for PCs at [www.altera.com](http://www.altera.com).
Software Installation

The instructions in this section explain how to install the following:

- **PCI Express Development Kit, Stratix II GX Edition CD-ROM**
- **PCI Express Development Kit, Stratix II GX Edition demo application and drivers**
- **The Quartus II Software, Development Kit Edition, including MegaCore functions from the MegaCore IP Library CD-ROM**

**Installing the PCI Express Development Kit, Stratix II GX Edition CD-ROM Contents**

The **PCI Express Development Kit, Stratix II GX Edition CD-ROM** contains the following items:

- **PCI Express Development Kit, Stratix II GX Edition GUI application and drivers**
- **Example design programming files**
- **PCI Express Development Kit, Stratix II GX Edition Getting Started User Guide** (this document)
- **Stratix II GX EP2SGX90 PCI Express Development Board Reference Manual**

To install the **PCI Express Development Kit, Stratix II GX Edition CD-ROM**, perform the following steps:

1. Insert the **PCI Express Development Kit, Stratix II GX Edition CD-ROM** into your CD-ROM drive.

2. Double click the `SIIGX_PCIe_Kit-v1.0.0` file.

   The CD-ROM should start an auto-install process. If it does not, browse to the CD-ROM drive and double click on the `setup.exe` file.

3. Follow the online instructions to complete the installation process.

The installation program copies the PCI Express Development Kit, Stratix II GX Edition files to your hard-disk, installs the software drivers and application, and creates an icon in **Programs > Altera > Stratix II GX PCI Express Kit v1.0.0** (Windows Start menu), which you can use to launch the Windows development kit GUI.

When the installation is complete, the PCI Express Development Kit, Stratix II GX Edition installation program creates the directory structure shown in **Figure 2–2**, where `<path>` is the PCI Express Development Kit, Stratix II GX Edition installation directory.
Software Installation

Figure 2–2. PCI Express Development Kit Installed Directory Structure

Table 2–1 lists the file directory names and a description of their contents.

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Description of Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>BoardDesignFiles</td>
<td>Contains the board design and production test files. You can use the board design files as a starting point for creating your own prototype board.</td>
</tr>
<tr>
<td>Docs</td>
<td>Contains the documentation related to the development kit.</td>
</tr>
<tr>
<td>Drivers</td>
<td>Contains the install.bat file, which installs the demo application’s driver files and the pcie.exe file.</td>
</tr>
<tr>
<td>Examples</td>
<td>Contains the example design files for the PCI Express Development Kit, Stratix II GX Edition.</td>
</tr>
</tbody>
</table>

Installing the Quartus II Software and MegaCore Functions

Refer to Installing the Quartus II Software in the Quartus II Installation & Licensing Manual for PCs for software installation instructions. After installing the software, request and install a license to enable it.

For information on obtaining a license file, refer to “Licensing Considerations”.

To use the Quartus II software included with the kit, you must first obtain a license file. A one-year Quartus II DKE software license is included with the kit.

During the installation of the Quartus II software, you are given the option to install the MegaCore IP Library. When prompted to do so, choose to install the MegaCore IP Library and follow the on-screen instructions.
Licensing Considerations

Before using the Quartus II software, you must request a license file from the Altera web site at www.altera.com/licensing and install it on your computer. When you request a license file, Altera emails you a license.dat file that enables the software.

To obtain a license, perform the following steps.

1. Point your web browser to the Altera web site at www.altera.com/licensing.

2. In the Development Kit Licensing list, select Licensing for RoHS Compliant Development Kits.

3. Follow the on-line instructions to request your license. A license file is emailed to you.

   Before installing your license, close the following software if it is running on your computer:
   - The Quartus II software
   - The MAX+PLUS II software
   - The LeonardoSpectrum synthesis tool
   - The Synplify software
   - The ModelSim simulator
   - The Precision RTL Synthesis Software

4. To install your license, refer to Specifying the License File in the Quartus II Installation & Licensing Manual for PCs, which is included with the kit.

Using the Kit’s Demo Application and Example Design File

The kit provides an example design file and an easy-to-use demo application with a custom graphical user interface (GUI). The demo application’s GUI allows you to:

- Specify endpoint (PCIe x8 MegaCore function) DMA read, write, and loop commands
- Specify memory read/write and loop commands
- Read various configuration and DMA registers

In this section, you will:

- Install the demo application drivers and PCI Express development board
- Perform memory read and write transactions on the board
- Read configuration and DMA registers
The Stratix II GX PCI Express development board ships with a pre-installed example design. For instructions on downloading the example design directly to the board, refer to Appendix A, Downloading Programming Files to the Development Board.

**Data Flow Block Diagram**

Figure 2–3 shows a block diagram of the data flow from the x8 PCIe edge connector through the Stratix II GX device block, which includes the application layer, Altera PCIe x8 MegaCore function, and the Quartus II software alt2gxb megafunction.

The kit’s demo application allows for memory read and write transactions to the development board. In addition, the kit’s example design (SIIGX_PCIe_Example_Design.sof) has a DMA engine that allows the development board to write to system memory.

![Figure 2–3. Stratix II GX Device Block](image)
Install Drivers and PCI Express Development Board

As stated in the “Hardware Requirements” on page 2–3, for a flexible setup that allows you to download different programming files to the on-board Stratix II GX device, you need two computers. Specify computer #1 as the development board host computer, and computer #2 as the Quartus II programming host computer.

This section discusses the example design and the development board host computer (computer #1). For information on using the Quartus II programming host computer (computer #2), refer to Appendix A, Downloading Programming Files to the Development Board.

To install the demo application drivers and PCI Express development board, use the following steps:

1. To install the drivers, you need to have administrator privileges on your computer.

From computer #1:

1. Install the PCI Express Development Kit, Stratix II GX Edition CD-ROM.

2. Open the Drivers directory, and double-click the install.bat file.

3. After the install.bat file is finished copying files and installing the drivers, shutdown computer #1.

4. Insert the PCI Express development board in a x8 PCIe slot.

Finish Installing the Drivers and the Development Board, Run the Demo Application

In this section, you will finish installing the demo application drivers and the PCI Express development board; then run the demo application.

1. Start computer #1.

2. The Windows XP Found New Hardware Wizard appears. See Figure 2–4.
Using the Kit’s Demo Application and Example Design File

**Figure 2–4. Found New Hardware Wizard Window**

3. Click Next.

4. The Hardware Installation window appears (Figure 2–5).

**Figure 2–5. Hardware Installation Window**

5. Click Continue Anyway.

6. Click Finish in the Completing the Found New Hardware Wizard window to finish installing the drivers.
7. To execute the demo application’s GUI, run the kit’s demo application from the shortcut, Start > Altera > PCI Express Development Kit, Stratix II GX Edition v1.0.0, or execute the pcie.exe file found in the <path>\SII_GX_PCIe_Kit-v1.0.0\SII_GX_PCIe_Example_Design\Drivers directory.

   If you receive an “Application Error” message when launching the demo application, please install version 1.1 or later versions of the .NET framework. Some Windows versions do not have runtime DLL for the .NET application. The .NET framework application can be downloaded from the following location:

8. Configure the parameters in the Altera PCI Express Demo Kit Application window as shown in Figure 2–6:
   - Under Commands, turn on EP DMA Loop.
   - Under Address/Size:
     - Type 0x0000000 in the Address Offset box.
     - Type 2048 in the Transfer Length box.
     - Type 1000 in the Iterations box.
     - Select Random Packet in the Data Type list.

9. Click Execute. The following message appears,
   "***SUCCESS***."

The demo kit application can be configured to perform other tests including memory read and write transactions on the board, loop read and write transactions, and also read the various configuration and DMA registers. For more information about performing other tests, refer to the PCI Express-to-DDR2 SDRAM Reference Design Application Note.
Figure 2–6. Altera PCI Express Demo Kit Application Window
Appendix A. Downloading Programming Files to the Development Board

Introduction

The Stratix® II GX PCI Express development board is shipped pre-programmed with the factory example design; however, you may want to download your own design. This section discusses how to download other design files.

This document assumes that the development board is plugged into a computer with a PCIe x8 slot. However, an external power supply and cables have been provided to either run the board external to a PCIe chassis, or provide more power than is available from the host computer. To use this power supply, connect the power cable to the board and plug the other end into a power outlet. To power up the board, place the power switch (SW1) in the ON position. When power is supplied to the board, the LED (D19) illuminates.

If the board does not power up after the power cable is connected, ensure that the power switch (SW1) is in the ON position.

Connect the USB-Blaster Cable to the Board

An Altera® USB-Blaster™ cable is provided with the kit. Connect the USB-Blaster cable’s 10-pin female plug to the Stratix II GX device’s JTAG header on the Stratix II GX EP2SGX90 PCI Express development board (U10), and connect the other end to the USB port on the computer running the Quartus® II software.

This approach allows you to directly configure the Stratix II GX device using an SRAM Object File (.sof). The kit’s reference design includes a SOF for directly configuring the Stratix II GX device.

When connecting the JTAG side of the USB-Blaster cable, connect the marker line on the cable to pin 1 of the header (J5). Pin 1 of J5 is numbered on the board.

The USB-Blaster download cable driver must be installed before the USB-Blaster download cable can be used. For information about installing the USB-Blaster download cable driver included with the Quartus II software, refer to the USB-Blaster Download Cable User Guide. The driver files are installed at `<quartus-install-dir>\drivers\usb-blaster`. 
To program the on-board FPGA with the example design file and view the state machine status via the Quartus II software’s SignalTap® II Logic Analyzer, use the following steps:

1. Start the Quartus II software.
2. On the Tools menu, click SignalTap II Logic Analyzer.
3. From the File menu, browse to the `<path>`/SIIGX_PCIe_Kit-v1.0.0\Examples\SII_GX_PCIe_Example_Design directory and open the PCIe SignalTap II file, SIIGX_PCIe_Example_Design.stp.
4. From the same directory as the SignalTap II file, download the PCIe SOF file, SIIGX_PCIe_Example_Design.sof.

After the board powers up, the on-board flash memory—which ships pre-programmed with the factory design—automatically configures the Stratix II GX device. The CONF DONE LED illuminates, signaling that the Stratix II GX device is configured.

In Figure A–1 the SignalTap II Logic Analyzer displays the status of the `ltssm` state machine 0x0F, which indicates that the x8 PCIe MegaCore® function is in the L0 state.

For more information about the SignalTap II Logic Analyzer included with the Quartus II software, refer to the Design Debugging Using the SignalTap II Logic Analyzer chapter in volume 3 of the Quartus II Handbook.
Download Example Design SOF and View State Machine Status